Basics Lesson Seven ‐ Organizing Windows
Understanding Files and Folders
 A File is a single individual computer object, in effect, any single entity. It is always contained
within a folder (The C drive being the largest folder).
o Such as a word processing document, a picture, a music file, a program file, or even a
shortcut to any of the above (document, picture, music, program file)
 Simply speaking, a file is anything other than a folder.
 A Folder is a place where files and/or additional folders are stored. In other words, a Folder is
just a Container for files or more folders, or both.
 Files must be stored within folders. They must be “contained” in something.
o If stored on the root drive they may seem "loose", but the C drive as I said is actually a
huge folder.
 Folders can contain one or more Files, one or more Folders, or both Files and Folders.
o An analogy is to think of a file as a single candy bar.
o Consider a Folder to be a carton labeled "candy bars". This carton may contain boxes of
candy bars, individual candy bars, or both. In other words, the carton (folder) may
contain only one single candy bar (file); the carton may be enlarged to hold (contain)
several loose candy bars (individual files); the carton (folder) can be so large as to hold
one or more boxes of candy bars as well as individual candy bars; or the carton may be
organized and hold only boxes of candy bars, without any loose candy bars.
o Realize that each folder (box) within that first carton (folder) can hold both loose
individual candy bars, and/or more boxes of candy bars (more folders). You can have
box within box within box.
o A “parent folder” is the folder within which other folders reside.
 Those folders within that folder are called “sub‐folders” (of the parent).
 A folder can be both a parent folder and a sub‐folder.
 The sub‐folder is the "parent" to any folders within it.
o Using a similar candy bar analogy, the carton (also a box) containing boxes of candy bars
above, is the "parent" to those boxes of candy bars. Each box of candy bars within the
carton is a "sub‐box" of the carton.
 Stores have those cartons of candy bars delivered.
 The delivery truck which delivered those cartons contains multiple cartons of
candy bars.
 Thus the delivery truck could be considered the "parent (folder)" of each carton
it delivered.
 And each of those cartons represented a “sub‐folder” of the truck.
 Remember, a folder can contain just files, just folders, or both files and folders.
 A File cannot contain Folders or additional files. The file is an individual entity, not a container.
 Both Files and Folders have names. Files MUST be provided names in order to be saved.
Folders created, on the other hand, if given no intentionally descriptive name, are given the
name (label) “New Folder” by Windows. Since no file within the same folder, nor folder within
the same parent folder can have the same identical name, an unnamed second folder is given
the name “New Folder [1], or [2], etc). A file may be given a name by Windows based on its
contents, such as the first few words of a word processing document; otherwise it may simply
be named "untitled document".
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What is in a file name?
 A “filename” consists of name established for it followed by its’ extension, such as: Story.doc,
Landscape.bmp, or shortcut.ink.
 The extension tells Windows how to recognize each file type, and with which program it should
use to re‐open or display the file (this refers to the file association, the program the file is
“associated with”).
 Without its extension, Windows doesn’t know with what program to use in order to display the
file, thus Windows comes up with the “Open with” (or “Choose a program from a list)” dialog
box; or in Windows Vista, the window containing radio buttons allowing the user to let
Windows “Use the web service to choose the correct program”, or “Select a program from a list
of installed programs”.
About File Names and Extensions
 Every file should have (originally had) an extension, whether Windows displays it or not.
o If no extension is visible, you have most likely have the computer configured to hide
known extensions (see " Viewing Files and File extensions" below).
o Occasionally there is an accidental exclusion during the original naming, or renaming of
the file, thus no apparent extension is visible even if extensions are configured to show
(see below); but don't concern yourself too much with that right now.
o Just understand without the extension, Windows does not know which program to use
in order to open it.
 In such a case of missing or unrecognized extension, you may have to try
(experiment with) various programs to find what will open such a file.
 Remember if you do that, there is a check box instructing Windows to “Always
use this program for these file types”.
 Don’t have that box checked when trying various programs. Remove the check.
 Only after successfully opening the file, repeat the process and add the check.
 Understand Folder names do not have extensions, since they are only containers. Only
individual files have extensions. Windows always knows how to open a folder (container).
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Viewing Files and File extensions
 Windows Setup (original installation) by default does not show all files and folders.
o It hides the files and folders Windows uses to operate.
 In other words, some files and folders are hidden from view initially.
 Windows also initially hides file name extensions for recognized file types.
 For what purpose does Windows initially hide these files and folders?
o Windows attempts to keep unknowing hands from accidental deletion of, or moving of
critical Program and Windows files.
o These are not files the casual computer user normally needs to view or manipulate.
o But it can be necessary for these files and folders to be “seen” when troubleshooting or
more advanced activities are required.
 Such as to copy or back up such files and folders
 If they remain hidden, earlier versions of Windows did not necessarily back them
up or copy when copying the contents of a folder. In those versions, if you try to
copy a folder containing hidden files or folders, Windows often warned you of
that fact.
o Once it is necessary for you to copy hidden files or back up (you now are doing
important things that you do not want to lose, or that you want to share), you are no
longer a casual user.
o Moving, deleting, or even renaming any of these hidden files or folders can render a
program, or even Windows itself inoperable, requiring reinstallation.
 To reveal these hidden files and folders, and show hidden extensions, you will need to make
changes to Folder Options (Folder and Search Options on latest versions). Find Folder Options:
o The first step is to open File (Windows) Explorer. (the folder icon on the Taskbar.
 Or simply open a File (Windows) Explorer window
 Such as Documents or This PC (My Computer).
o Next open Folder Options. To do so differs from Windows versions.
o Windows 8 and 10 use a ribbon interface, so go to the View ribbon.
 To the right half of the View ribbon, you see check boxes for displaying Hidden
items and File name extensions.
 Checking those boxes makes the necessary changes.
 Clicking the Options button (far right) opens the same as described below.
o Windows Vista and 7 have the “Organize” menu containing “Folder and Search
Options”, or use Control Panel/Folder Options. Now click on the View tab.
 Select the radio button “Show hidden files and folders”.
 Remove the check from “Hide extensions of known file types”.
 Apply the changes and OK.
o Windows XP displays a Tools menu with “Folder Options” at the bottom, or similarly use
Control Panel/Folder Options. Again, click on the View tab.
 Select (radio button) “Show hidden files and folders”
 Remove the check from “Hide extensions of known file types”.
 Apply the changes and OK.
o Don’t confuse “Hide extensions…” with “Hide protected system files”. Leave “Protected
system files” hidden.
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Viewing Files and File extensions (cont’d)
 Reasons for revealing file extensions:
o Allows you to recognize all file types.
o You cannot be erroneously misled into thinking a file is “safe” because it was disguised
with a clever name. Be aware, you can give a file a name which contains a period, such
as “file.jpg”, which is actually "file.jpg.jpg" when the extension is visible, a harmless
photo.
 But if the extension is not visible you fail to realize it is really “file.jpg.scr”, or
"file.jpg.exe". Which is not actually a safe photo, but instead a screensaver or
other executable file capable of performing malicious actions, or installing
malware on the computer.
 Be mindful when the file extension is visible during renaming of a file.
o Renaming of files can result in accidental loss of the extension. Use CTRL‐Z immediately
to undo such loss.
 Must be sure not to include the extension when renaming a file.
 Windows 10, 8, 7, and Vista all exclude the extension in the selection during a
file renaming.
 But you can accidentally add it to the selection.
 Windows XP (and before) included the extension in the selection all the time.
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Understand how a computer organizes everything
 Consider your hard drive (usually Local C:) one huge Filing cabinet drawer. (It is also technically
a huge folder).
 If you have more than one hard drive, consider the hard drive to be the Filing cabinet, and each
drive letter a file cabinet drawer.
 Within the C: drive (file cabinet) there are several major folders created during the installation
of Windows, the most important of these:
o “Program Files” and "Program Files (x86)"
o “ProgramData” (will only display if Hidden files are checked)
o "Users"
 Contains each user's personal files (Documents, Pictures, etc.)
 Previously “Documents and Settings” in Windows XP
o “Windows” (or “Winnt”).
 Whenever programs are installed, each program creates usually one folder within the “Program
Files” or "Program Files (x86)" folder.
o Within those single named Program Files folders are typically placed one or more “sub‐
folders” essential to each program’s operation, and named after the program it
represents (contains), such as "Norton Internet Security" or similar.
o This avoids clutter, by having only one main folder for each program installed.
 Windows keeps all of its necessary files, folders, and included programs and features within the
Windows (WinNT) folder.
 All the user generated information is contained within folders kept under each user’s name and
within either the "Users" folder (“Documents and Settings” on Windows XP).
o Each user has their own single named folder within which contains multiple additional
“sub” folders
o Within each Username folder is a hidden folder labeled "AppData" which contains much
user system critical information.
 Windows XP contained this information in "Application Data" (or in “All Users”
folder for information used by every named user).
o Such common data to all users is now kept (beginning with Windows Vista) under the
hidden "ProgramData" folder mentioned above.
 There is also typically at least one folder labeled by the computer manufacturer.
o Usually also located under the C: drive, or the Program Files folder.
 Beyond these folders, everything installed steadily increases the number of folders,
subfolders…and of course files.
 Very few programs have not followed the convention.
o But just to be sure, always look under the C drive for such a program.
 You can create folders anywhere.
o I suggest avoiding using the System created folders listed above.
 Creating a new‐named file or folder, even within critical folders does not usually
cause any problem, but it is still wise to avoid the practice.
 Creating a new folder of the same name as, or renaming a file or folder within a
critical folder, could wipe out or corrupt a necessary group of files.
o Create folders preferably only under the Username folder or sub‐folders to be safe (My
Documents, My Pictures, My Music, etc.).
 Just keep it orderly and logical.
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Understand how a computer organizes everything (cont’d)
 Documents [My Documents]
o This is a sub‐folder under the user‐named folder.
o Each User has his or her own User_Name folder.
 Under which exists a “[My] Documents” folder.
 But when logged in as User_One, an additional user’s (User_Two) documents, if
listed, may be labeled as “User_Two’s Documents” rather than just
“[My] Documents”, to avoid confusion.
 The primary (logged in) user’s documents will be listed as “My Documents”
o By keeping any documents you create within “My Documents” (or similar "My folders
within the User_name folder), you always know where everything important resides.
 For example then, by selecting all the "My…" folders (such as My Documents" in
your backup, you insure you have saved (backed up) everything irreplaceable.
 Otherwise, sometimes backing up the entire Username folder becomes difficult
or tedious.
o Historically, Windows XP “My Documents” contains within it all the users My folders
“My Pictures”, “My Music”, and all other “My” folders.
 The above general holds true, but with these Important Exceptions if backing up data:
o AOL mail messages “Saved on My PC” mail is “buried” more deeply.
 Saved messages reside in (path to) the C:\ProgramData\AOL 9.x\organize folder.
 This nomenclature means the "path" to the AOL message folder is
C:\ProgramData\AOL 9.x\organize, or in other words contained within the files
contained within the "organize" folder, that folder residing within the "AOL 9.x
folder, which in turn is within the "ProgramData" folder; and that ProgramData
folder is listed (or resides in) the C:\ drive.
o Windows Live Mail messages are similarly buried.
 This time under C:\Users\User_name\AppData\Local\Microsoft\Windows Live
Mail.
o Refer to our step‐by‐step instructions for more information regarding these backups.
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Creating Files or Folders
 Remember, creating a file is what you do any time you save something (create a spreadsheet,
write a letter, save an e‐mail, or import a photo, for example.)
o Whenever you save something, you must give it a name.
o Windows automatically attaches the extension to it based on the type program you
used while saving it.
o When you save a file, it is placed within a folder.
o You can either tell it which folder to use.
o Or Windows will decide, often based upon which folder into which you last saved
something.
o Problem: If Windows decides and you do not pay attention where Windows is putting
it, you may have difficulty finding it later!
o Windows has made searching for files fairly easy if you know something about the
name or content of the file you are seeking.
o You can use an already existing folder to save
something within, or create a new folder. The
appearance differs depending on the program and
Windows version. Sometimes it uses the traditional
appearance shown here.
Other times it shows the Organize bar.
And
still other times it uses the File (Windows) Explorer New Folder icon
look.
o On Vista, New Folder may be under
the Organize menu, or a New Folder
button.
 If you create (or rename) files prior to, or after, using the Save As dialog box (during the Saving
process), Windows provides many ways of creating new folders.
o New Folder is a task button available on the Home ribbon at the top of each File
(Windows) Explorer window.



 Or in the left‐hand Task Pane of Windows XP (not shown).
 In Vista, the Organize menu offers to create a “New Folder” (shown just above).
 The “New Folder” button is at the top Task bar in Windows 7.
o Usually the right‐click menu offers New Folder as a choice from the "New" menu.
o Any Save As box contains a “Create New Folder” icon or button (as shown and
mentioned above).
o The File menu of the older programs also often offers to create a new folder.
o And a keyboard shortcut, right‐click and then type "W" followed by "F".
Don't Panic! You needn't learn all these ways of creating a new folder, focus on the one you like
(or can remember easiest).
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Navigating (Using) File (previously Windows) Explorer
 Saving within an already existing folder requires “navigating” to that folder (getting to the
desired folder by opening folders until within the desired folder. Remember you must be
within that folder, not just seeing the folder displayed (in that case you would really be saving
into the "parent" folder of the folder you really intended.
o Again, depending on the program
and Windows version that may
entail "navigating" to the desired
folder by using the drop‐down
folder tree at the top







o Use the Up button
or
to
back up until getting to the desired parent folder.
o Or you may need to navigate using the more modern
appearance.
File (Windows) Explorer is any window which opens
displaying files or folders.
The File Explorer windows is composed of a left "folder"
pane, and a right "contents" pane.
The Folder pane on the left includes the Quick Access (previously labeled Favorite Links), and
below it the folder list.
o Click on a folder contained in the Quick Access list, or click through folders in the Folder
list. The contents of each folder is displayed on the right in the Contents pane.
In the right‐hand Content pane, double‐click to open a folder, and continue double‐clicking
folders until getting to the desired folder.
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Viewing Files and Folders
 Viewing Files and Folders, as described previously, Windows displays two panes, a left‐hand
"Folder" pane, and a right‐hand "Contents" pane.
o The left‐hand pane contains the “Folder Tree” below the Quick Access items, and This
PC items (Windows 8 and 10).
o The contents of the folder which is open (selected) in the left‐hand Folder pane is
displayed on the right side in the "Contents" pane.
o Notice that only folders are displayed in the left‐hand pane (reason for calling it Folder
pane).
o
Folders containing more folders (or i.e. Sub folders) are shown as such by being
preceded by a plus sign or horizontal caret .
 Clicking on the caret (or plus sign) opens (“expands”) that folder, displaying the
sub folders.
 When the folder is expanded, the plus sign changes to a minus sign, or
horizontal‐directed caret changes to a downward‐slanted caret .
 Similarly, if the sub folder still has more folders with in it, there is again a plus
sign or caret preceding it.
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Re‐naming or Deleting Files or Folders
 Renaming files or folders is accomplished by either:
o Right‐clicking on the file or folder and choose “Rename”
 Be aware XP selected the name and extension, (if still using XP).
o Click once to select, then once again (do not double‐click). This causes the name to be
selected (same as if you chose Rename). You can now rename.
 This is why sometimes when you think you are double‐clicking, that funny
pulsation and/or change of color of the name occurs instead.
 To avoid this ALWAYS double‐click on the icon, not the name.
 Remember, anything selected will be replaced.
 If you messed up and replaced everything, quickly hold down the CTRL
key and hit the letter "Z". This should return the name to the original.
 If want just to change a letter or word, first hit the left or right keyboard arrow
key (to unselect everything).
o Look in the Home ribbon for the “Rename” button.
Remember it will be
dimmed (as on page 7, until you choose something.
 On Windows XP Rename is in the left Task pane.
 On Vista and Windows 7 it is in the Task bar (not Taskbar).
 Or instead choose rename from the Organize menu.
o As I mentioned, use caution if you have the extensions selected during this process.
o Do not change the extension portion of a file name (or the period immediately
preceding the extension).
o Windows does not permit the use of certain special characters in file or folder names.
 Windows will remind you if you do ( / \ “ : * ? | < > )
o Also you cannot rename any file currently in use by a program.
 Nor if it is showing in another Explorer window.
 Sometimes, even though you are out of the file, and windows are closed,
Windows still insists the file is in use.
 If all windows are closed and it still refuses, try restarting your computer.
 Deleting files and/or folders is accomplished by selecting the file/folder, then:
o Hit the Delete key on the keyboard.
o Use the Right‐click menu command: “delete”.
o Use a Delete button when available on the toolbar, ribbon, task bar, or task
pane.
o Use a Delete command from either an Edit, File, or Organize menu.
o When you delete something, it customarily goes to the Recycle Bin unless too large a file
(hundreds of MBs or several GBs)
 Windows provides an override to prevent going to the Recycle Bin.
 But I do not usually advise it!
 Hold down the SHIFT key as you click or hit Delete, and instead of offering
to send it to the recycle bin, it will inform you it is being permanently
deleted, and require confirmation that is you desire.
 We all make errors in judgment and this is permanent.
 Items can be retrieved from the Recycle Bin, but not if Recycle Bin is bypassed.
o Windows 10 by default no longer warns of a deletion. Change it by right‐clicking on the
Recycle Bin and choosing properties, and checking "Display delete confirmation".
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Understanding the Recycle Bin
 The Recycle Bin is really just another folder…but a last resort folder.
o You can see what files or folders are in the Recycle Bin, but cannot open any item from
within the Recycle Bin. In order to open a file or folder that is in the Recycle Bin, first
either “Restore” it to the original folder, or drag it from the Recycle Bin onto the
Desktop.
 But remember, once dragged to the Desktop, Windows no longer remembers
which original folder to restore it to. It will then restore it to the desktop if again
deleted.
 Obviously you do not want to Save anything to the Recycle Bin, should you be given such an
option (probably will not).
 Everything deleted passes through the Recycle Bin before being permanently and irretrievably
deleted by “Emptying the Recycle Bin”.
 The size of the Recycle Bin is set by a percentage of your hard drive.
o If a file or folder is larger than the remaining space in the Recycle Bin, a message is
displayed indicating that, and asking if you want to delete it anyway.
o Doing so will permanently delete that file or folder.
 Retrieving (Restoring) an item from the Recycle Bin, and placing it back into its original folder
involves merely opening the Recycle Bin by double‐clicking on the desktop “Recycle Bin” icon,
finding the item, and either:
o Right‐clicking and choosing “Restore”
o Choosing “Restore selected items” from the Recycle bin's "Manage" ribbon.
 From the left‐hand task pane (XP).
 From the Task bar button (Vista and Windows 7)
 You can also selectively permanently delete only selected objects, rather the emptying the
entire recycle bin by choosing Delete on the Home ribbon (Windows 8 and 10).
o Or by the same locations described under Restoring items and choosing Delete
(Windows XP, Vista, and 7).
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Organizing, or re‐organizing, My Documents (Documents) or any other folder
 As easy as creating folders within folders and giving them useful, meaningful but short names
o Don’t make names too long.
o But long enough to make it easy to remember what the folder contains
o As stated much earlier, two files, or two folders, within the same folder cannot have
identical names.
 Add another character (such as number, letter, dash or underscore)
 Within the same folder, Windows does allow an identical name for a file and one
folder, just not two files or two folders.
o But you can have identically named files or folders within different “parent” or "sub"
folders.
 Don’t end up with too many identical non‐specific named folders
o Such as having a folder named “E‐mail” within fifty or sixty different folders
 Should one get accidentally moved or deleted, there is no way of knowing to
where it should be returned, or which folder (if multiple named folders) needs to
be restored.
 If in the Recycle Bin, and never having been moved from there, Windows usually
knows where it belongs when choose Restore.
o Understand Windows does have limits to the file or folder name, and:
 The file or folder name includes the entire "path" as part of the name, so the
filename you think is simply "Minutes" is actually "
C:\Users\Username\Documents\Desired folder\Minutes".
 For archiving, it is wise to put a copy of any settings folder or configurations within [My]
Documents (or similar "My…" folder) if possible.
o It again makes backup easy later.
o Example: Redirect Windows Live Mail store or Windows Mail to Documents.
 Or save a copy of Windows Live Mail folder, Windows Live Mail Accounts to the
[My] Documents folder (or whichever mail program you use).
o Export your Email Contacts (address book) to My Documents periodically (usually as a
CSV file).
o Make screen shots of important configuration settings not readily exported or copied.
 Bring up the Configuration window, then “Print Screen” or ALT‐PRINT SCREEN,
then paste into Paint or Word, and save file to [My] Documents with a
descriptive name.
 Change the location (Target destination) of Documents, Pictures, Music, etc.
o Right‐click, choose Properties, and select target or Location tab from Properties.
 HINT: When naming folders or pictures (files) by date, in order to keep each year's file together,
START the name with the year, not the day or month.
o Otherwise all the many January files or folders will be first 1990 through 201X, before
the February, and so on.

12

